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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the 
use or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., 
is prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

 
WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to 
personal injury or death, property damage, or economic loss. 

 

 
ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

 
IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

 
SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

 

 
BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 
temperatures. 

 

 
ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash 
will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and 
for Personal Protective Equipment (PPE). 

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are 
not in alignment with the movement toward inclusive language in technology. We are proactively collaborating with 
industry peers to find alternatives to such terms and making changes to our products and content. Please excuse the use of 
such terms in our content while we implement these changes.
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Preface 

Contact Rockwell Automation Technical Support 
If you have questions about the product, consult the manuals, Help, or Release Notes. 

You can also search for technical notes, application tips, solutions to common problems, and the latest patches from 
Rockwell Automation Knowledgebase https://rockwellautomation.custhelp.com. 

If you cannot find the answer, contact Rockwell Automation Customer Support, using any of these methods: 

• Customer support telephone: 1.888.382.1583 or 1.440.646.3434 
• Local technical support phone numbers: https://rockwellautomation.custhelp.com/app/phone 
• Online support: https://www.rockwellautomation.com/en-us/support.html 

Support staff are available Monday to Friday from 8:00 to 17:00 local time (North America only), except on statutory 
holidays. 

When you call, it is recommended that you be at your computer and ready to provide the following information: 

• the product serial number and product key. 
• the product version number. 
• the type of hardware you are using. 
• the names of Rockwell Automation products installed on the computer. 
• the exact wording of any messages that appeared on your screen. 
• a description of what happened and what you were doing when the problem occurred. 
• a description of how you tried to solve the problem. 

If you are running a FactoryTalk View SE network distributed application, also note: 

• how many computers are participating in the network application. 
• whether computers on the network are connected using a Windows domain controller or a workgroup. 
• which FactoryTalk View SE components are installed on participating computers. 
• which computers are running servers (the Network Directory server, HMI servers, data servers, or tag alarm 

and event servers), and whether the servers are set up with redundancy. 
• which computers are running clients (FactoryTalk View SE Client or FactoryTalk View Studio). 

 

 

http://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/app/phone
https://www.rockwellautomation.com/en-us/support.html
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Chapter 1 

FactoryTalk View basics 

FactoryTalk View, including FactoryTalk View Site Edition (SE) and FactoryTalk View Machine Edition (ME), is 
human-machine interface (HMI) software designed with a common look, feel, and navigation to help speed HMI 
application development and training time. 

FactoryTalk View provides monitoring and control solutions designed to span stand-alone machine-level 
applications up through supervisory-level HMI applications across a network. 

About FactoryTalk View SE 
FactoryTalk View Site Edition (SE) is an integrated software package for developing and running human-machine 
interface (HMI) applications that can involve multiple users and servers, distributed over a network. 

A FactoryTalk View SE system is more than the HMI server and clients. It also includes FactoryTalk Services 
Platform and data communication products such as FactoryTalk Linx. 

Architecture of the FactoryTalk View system 
A network distributed FactoryTalk View SE system consists of several components as shown below. 

FactoryTalk View SE network distributed system 

This example of a distributed system includes a FactoryTalk Directory server, FactoryTalk View SE server and client, 
FactoryTalk Linx data server, and FactoryTalk View Studio for application development and configuration. 

 

FactoryTalk View Studio Enterprise 
FactoryTalk View Studio Enterprise is the configuration software for developing and testing FactoryTalk View SE 
network distributed, network station, local station, and FactoryTalk View ME applications. 
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FactoryTalk View Studio is the design-time environment for FactoryTalk View that provides the editors and tools 
you need to develop and test network distributed, network station, and local station human-machine interface 
(HMI) applications. It contains editors for creating complete applications, and contains client and server software 
for testing the applications you create. 

 

FactoryTalk View SE Server 
FactoryTalk View SE Server, also called the HMI server, stores HMI project components (for example, graphic 
displays) and supplies them to clients. The server also contains a database of tags, and performs historical data 
logging. FactoryTalk View SE Server has no user interface. Once installed, it runs as a set of headless Windows 
services that supply information to clients as they request it. 

FactoryTalk View SE Client 
FactoryTalk View SE Client is software for viewing and interacting with FactoryTalk View SE local station, network 
station, and network distributed applications at runtime. Use the FactoryTalk View SE Client Wizard to create client 
configuration files that can be deployed to client host computers. 
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FactoryTalk View SE Station 
FactoryTalk View SE Station is a supervisory HMI software package for enterprise solutions. SE Station is a 
single-computer HMI that can be operated in either a Local or a Network FactoryTalk Directory. There are key 
differences between View SE Distributed and View SE Station: 

• View SE Distributed can share HMI screens and data with multiple clients. 
• View SE Station does not allow sharing of HMI screens or data to other View SE Stations. 

FactoryTalk View SE network station system 

Several different computers, each hosting a FactoryTalk View SE network station, can use a single FactoryTalk 
Directory server and a single FactoryTalk Linx communication server. While each network station HMI can access 
the same controller data, through the shared FactoryTalk Linx server, and the same directory resources through the 
shared FactoryTalk directory server, they can only access their own HMI data such as graphics, macros, and 
datalogs. 
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FactoryTalk View SE local station system 

A local station system can include several HMI computers, each with its own FactoryTalk Directory server and data 
server connection to the controllers. 

 

FactoryTalk ViewPoint 
FactoryTalk ViewPoint is an add-on to FactoryTalk View that provides for a fully scalable, fully animated, 
read-and-write view of existing Site Edition (SE) and Machine Edition (ME) web applications from a web browser. 

A web application consists of graphic displays selected from the FactoryTalk View application, converted for viewing 
in a web browser, and then published to a FactoryTalk ViewPoint Server (also called the web server). 

• For Site Edition applications, the FactoryTalk ViewPoint Server runs on a desktop or server computer. 
• For Machine Edition applications, a PanelView™ Plus operator terminal functions as the server. 

Stand-alone FactoryTalk Linx Server 
FactoryTalk Linx is a FactoryTalk Live Data server and can be enabled as a FactoryTalk Alarms and Events server. 
Your applications use FactoryTalk Linx to communicate with devices such as controllers and I/O scanners. 

Stand-alone FactoryTalk Directory Server 
FactoryTalk Directory provides a central lookup service for a FactoryTalk system so all definitions do not have to 
exist in a single physical project file. References saved by FactoryTalk Directory are used by FactoryTalk-enabled 
products and FactoryTalk services to locate definitions when they are needed. It allows clients to locate key 
configuration information such as system organization, server locations, and policy information. FactoryTalk 
Directory provides a common address or phone book of factory resources that are shared among 
FactoryTalk-enabled applications in a distributed system. 
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FactoryTalk Services Platform 
FactoryTalk Services Platform provides a set of common services (such as diagnostic messages, health monitoring 
services, and access to real-time data) for all the FactoryTalk products and applications used in a control system. 

FactoryTalk Administration Console 

FactoryTalk Administration Console is a stand-alone tool for developing, managing, and securing multiple 
FactoryTalk View applications. 

FactoryTalk Directory 

The FactoryTalk Directory centralizes access to system resources and names for all FactoryTalk products and 
components participating in an automated control system. 

The FactoryTalk Network Directory manages resources for FactoryTalk View SE network applications, and the 
FactoryTalk Local Directory manages resources for FactoryTalk View SE local applications. 

FactoryTalk Alarms and Events 

FactoryTalk Alarms and Events, which installs behind the scenes during FactoryTalk View SE installation, provides 
system-wide alarm monitoring and control centralized at the FactoryTalk Directory. 

To distribute device-based and tag-based alarms in a FactoryTalk View SE application, you can set up FactoryTalk 
Alarms and Events servers in the application. 

FactoryTalk Security 

FactoryTalk Security centralizes user authentication and authorization at the FactoryTalk Directory. 

FactoryTalk Live Data 

FactoryTalk Live Data manages connections between FactoryTalk products and data servers. 

FactoryTalk Diagnostics 

FactoryTalk Diagnostics collects and provides access to activity, status, warning, and error messages generated 
throughout a FactoryTalk system. 

FactoryTalk Activation 

FactoryTalk Activation services provide a secure, software-based system for activating Rockwell Software products 
and managing software activation files. 

Connectivity 
How you plan to obtain data for an application will determine which communications software you install. 

You can use FactoryTalk Linx, RSLinx Classic, or other software and devices that support OPC (OLE for Process 
Control) communications. 



 

14 Rockwell Automation Publication VIEWSE-IN003S-EN-E - March 2022  
 

 
Tip: FactoryTalk Linx is automatically installed for FactoryTalk View applications. 

FactoryTalk Linx 

FactoryTalk Linx is a communication server built around FactoryTalk technology to assist in developing and 
running your FactoryTalk View SE applications. 

For communications with Allen-Bradley local and remote devices, particularly with Studio 5000 controllers, 
FactoryTalk Linx is the recommended data communications software for FactoryTalk View applications. 

FactoryTalk Linx now allows you to create redundant controller shortcuts and to perform online tasks such as 
uploading and downloading Studio 5000 Logix Designer files.  

Installation package 
The Setup wizard offers the following options for FactoryTalk View SE applications: 

• Studio Enterprise 
• Site Edition Server 
• Site Edition Client 
• Site Edition Station 
• FactoryTalk ViewPoint SE 
• Stand-alone FactoryTalk Linx Server 
• Stand-alone FactoryTalk Directory Server 

The Setup wizard offers the following options for FactoryTalk View ME applications: 

• Studio for Machine Edition 
• Machine Edition Station for Windows 
• Stand-alone ME Transfer Utility 
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Chapter 2 

System requirements 

This chapter introduces computer and Microsoft Windows support information for a FactoryTalk View SE system, 
including: 

• Review computer hardware requirements on page 15 
• Review operating system requirements on page 16 
• Set up Windows domain or workgroup on page 17 
• Set up computers with names to be used in production on page 18 

What can I install and run on one server? 
In a network application, it is possible for a single server computer that meets the recommended requirements to 
host all of the following components: 

• One FactoryTalk View SE Server 
• One FactoryTalk Linx data server (which can also be set up as FactoryTalk Alarms and Events device-based 

alarm server, or also includes the secondary data server) 
• One FactoryTalk Alarms and Events tag-based alarm server 
• The FactoryTalk Network Directory 

If a network application requires multiple HMI servers, data servers, or alarm servers, to distribute the load, it is 
recommended that you install the necessary software and run the servers on multiple host computers. 

For information about setting up redundant FactoryTalk View SE servers, see FactoryTalk View Site Edition User’s 
Guide. 

Review hardware requirements 
Typically, application servers such as FactoryTalk View SE Server, FactoryTalk Alarms and Events, and FactoryTalk 
Linx will need to be sized with faster CPUs and more RAM than operator or engineering workstations. 

You should also specify a hard drive that has enough disk space to provide virtual memory that is at least twice the 
size of the physical RAM. 

The following is a sample specification of computer hardware to run FactoryTalk View SE applications aligned with 
the hardware used in product development testing. 

Type Description CPU RAM 
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Operator Workstation FactoryTalk View SE Client 
or 
FactoryTalk View SE Station 

Intel® Core™ i5 Standard Power processor 4 GB 

Engineering Workstation FactoryTalk View Studio Enterprise 
FactoryTalk Linx 
Studio 5000 

Intel Core i5 Standard Power processor 8 GB 

Application Server FactoryTalk View SE server 
FactoryTalk View Studio Enterprise 
FactoryTalk Alarms and Events tag-based server 
FactoryTalk Linx data server with FactoryTalk 
Alarms and Events enabled 

Smaller systems:  
Intel Core i5 Standard Power processor 

4 GB 

Medium to larger systems: 
Quad core Intel Core Xeon family 
processor 

8 GB 

 

Review operating system requirements 
The choices you make will depend in part on whether the computer is to host an application client or server. You 
might choose to run operator or engineering workstations in a Windows Server operating system, but that is not 
required. 

Recommended specifications for application servers are not as flexible, because server computers are more likely to 
host critical components and to handle more of the processing load in a FactoryTalk View SE application. 

FactoryTalk View SE is tested on operating systems installed from original Microsoft media only. FactoryTalk View 
SE runs on the following Windows operating systems: 

• Windows® 10* (v2004, v20H2, v21H1, and v21H2) 
• Windows 10 IoT Enterprise 2016 Long-Term Servicing Branch (LTSB) 
• Windows 10 IoT Enterprise 2016 (LTSB) Embedded** 
• Windows 10 IoT Enterprise 2019 Long-Term Servicing Channel (LTSC) 
• Windows 11 
• Windows Server® 2012 
• Windows Server 2012 R2 
• Windows Server 2016* 
• Windows Server 2019 

* For more information, see Rockwell Automation Knowledgebase Document ID: IN4493 - Windows 10 
Support for the FactoryTalk Suite of Rockwell Software products and IN4718 - Windows Server 2016 Support 
for the FactoryTalk Suite of Rockwell Software products. 

** This operating system is supported with the Allen-Bradley® 61xx family of industrial computers and 
CompactLogix™ 5480 family of controllers. 

Recommendations for application servers 
For computers hosting application servers (HMI servers, data servers, or Tag Alarm and Event Servers), operating 
system requirements depend on whether the server will support more or fewer than 10 client connections. 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/964391
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/964391
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/991031
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/991031
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A client can be any of FactoryTalk View SE Client, FactoryTalk View Studio, the FactoryTalk View SE Administration 
Console, a FactoryTalk Historian SE connector, a FactoryTalk Transaction Manager connector, or another 
FactoryTalk View SE Server. 

For application servers that support: 

More than 10 client connections, the recommended operating systems (with the appropriate number of Client 
Access Licenses installed) 

• Windows Server 2012 
• Windows Server 2012 R2 
• Windows Server 2016 
• Windows Server 2019 

10 or fewer client connections, the minimum requirement is 

• Windows 10 
• Windows 11 

 
Note: Do not run the primary and secondary servers in a redundant server pair on the 
computers that have different operating systems. For example, do not run the primary 
server on a Windows Server 2012 computer and the secondary server on a Windows Server 
2016 computer. 

 

Set up the Windows domain or workgroup 
The number of computers participating in a FactoryTalk View SE network application determines whether the 
computers can belong to a Windows domain or a workgroup. 

Workgroups can be used only in applications that include 20 or fewer computers. Do not use Windows Workgroups 
with more than 20 computers, a Windows domain is recommended in that case. 

For more information about setting up domains and workgroups, see the document, FactoryTalk View SE Distributed 
System Design Considerations, attached to Knowledgebase Document ID: IN3416 - FactoryTalk View SE Distributed 
System Design Considerations. 

• A domain controller makes it possible to administer the network and user accounts from a central location. 
FactoryTalk Security, which manages centralized security services, supports Windows-linked accounts that 
are managed and authenticated by the Windows operating system, but have separate permissions for 
accessing the automation system. 

• Name resolution is required for the computers to communicate with each other on the network. 
• All computers participating in a single FactoryTalk system must be members of the same Windows domain. 
• Do not locate the domain controller on the same computer as any FactoryTalk software. Microsoft 

recommends against third party software being installed on a domain controller. 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/32549
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/32549
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Domain controller requirements 
For network applications consisting of more than 10 computers, the use of a domain controller is strongly 
recommended, but not required. The following domain controllers are supported: 

• Windows Server 2012 
• Windows Server 2012 R2 
• Windows Server 2016 
• Windows Server 2019 

 
Note: Do not install FactoryTalk Directory, FactoryTalk View SE Server, or any other 
application software on the same computer as the Windows domain controller. This 
configuration is not supported. 

 

Windows workgroup requirements 
For network distributed applications consisting of 10 computers or fewer, FactoryTalk View SE can be used in a 
Windows workgroup network environment. 

• Name resolution is required for the computers to communicate with each other on the network. 
• Workgroups do not use a domain controller, so central network administration is not available. This means 

that security and network communications (for example, name resolution) must be handled at each 
individual computer in the workgroup. 

• Each workstation in a workgroup must have the same user accounts, with the same user names and 
passwords on each machine, for all machines participating in a client-server environment. 

• All users in a workgroup should have Administrative rights assigned to them. 
• FactoryTalk Directory provides centralized security services without requiring a Windows Server and 

domain controller. When setting up security for applications in a Windows workgroup, it is recommended 
that you use the FactoryTalk Directory user accounts. This simplifies account management, by centralizing 
security services at the FactoryTalk Directory. 

About synchronizing time on application computers 
In a networked system, to ensure that time stamps on alarms, historical data, and diagnostics are accurate, it is 
highly recommended that time synchronization be configured on all application computers. 

For more information about synchronizing application computer clocks to an authoritative time server, see 
FactoryTalk View SE Design Considerations, attached to Knowledgebase Document ID: IN3416 - FactoryTalk View SE 
Distributed System Design Considerations. 

Set up computers with names to be used in production 
When you install the FactoryTalk Services Platform with FactoryTalk View SE, the program creates a FactoryTalk 
account for the current computer, under the Local and Network FactoryTalk Directories. 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/32549
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/32549
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As a result, if you rename the computer after installing FactoryTalk View SE or when you deploy an application, the 
FactoryTalk Directory will not recognize the new name. 

To avoid this problem, it is recommended that you give the application client and server host computers the names 
they will use in a production setting, before you install the FactoryTalk View SE software. 

 
Tip: If you must rename a computer and you encounter problems, for assistance, see 
Knowledgebase Document ID: BF20782 - FactoryTalk View SE: Inability to access FactoryTalk 
Network Directory after renaming computer (for FactoryTalk View SE network applications), or 
QA3873 - Renaming a PC with ME/SE Local Security (for FactoryTalk View SE local and ME 
applications). 

 

 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/35169
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/35169
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/38775
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Chapter 3 

Pre-installation configuration 

This chapter guides you through the steps for preparing your computer for installation of the FactoryTalk View SE 
product and supporting software. 

Use the following checklist for preparing the computer for installation: 

• Disable Windows automatic updates on page 21 
• Manually configure Network Interface Cards and switch ports on page 21 
• Disable or uninstall third-party firewalls on page 22 
• Remove Internet Explorer Enhanced Security Configuration on page 22 
• Set up Data Execution Prevention on page 22 if needed 
• Remove unnecessary DCOM networking protocols on page 23 

Disable Windows automatic updates 
When you install Microsoft Service Pack releases and other Windows operating system updates, you introduce new 
software that could affect the operation of FactoryTalk View SE components on the computer. 

 
Note: Windows updates should be disabled in all production computers. Updates can cause 
unexpected behaviors, including shutting down running applications and automatically restarting 
the computer. 

 

Configure NICs and switch ports 
The Network Interface Card (NIC) is the hardware in a computer that lets it connect to other devices on the network. 
A switch manages traffic on the Ethernet network. Some switches allow ports (physical connections) to be 
configured individually. 

The link speed and duplex settings for network connections can be auto-negotiated (the device determines the best 
way to communicate), or manually configured (settings are hard coded). 

Many NICs also offer a power-saving feature that turns off the network card if it is not being used. This setting 
sometimes interferes with the ability of the computer to receive data, causing errors such as wireframes, stale data, 
and other failures. To prevent these errors, disable power saving for your computer’s network interface cards. 

For FactoryTalk View SE applications, it is recommended that you use managed switches across the control system 
network and that you manually configure the same link speed and duplex setting for all network connections into 
the managed switches. 
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It is also recommended that you manually configure the managed switch ports, using the same settings. To learn 
how to configure switch ports, see the product documentation provided with the switches you are using. 

For an overview of best practices for connecting devices over a network, see the Ethernet Reference Manual document 
in the Rockwell Automation Literature Library. (Search for publication ENET-RM002.) 

 
Note: If you are using unmanaged switches, the NIC settings must remain auto-negotiated. 
Connecting an auto-negotiated device to a manually configured device can result in network 
communication errors and is not recommended. 

 

Disable or uninstall third-party firewalls 
FactoryTalk View SE is tested and compatible with the built-in Windows firewall. FactoryTalk View SE is not tested 
with third-party firewalls. We recommend that you not use third-party firewalls because they may cause unexpected 
results. 

Before installing FactoryTalk View SE, disable or uninstall all third-party firewalls on the computer. For details, see 
the documentation supplied with your firewall product. 

Remove Enhanced Security Configuration 
Internet Explorer Enhanced Security Configuration (ESC) is a group of default security settings for Windows 
Server 2012 and Windows Server 2016 that protects servers by limiting the ways users can browse Internet and 
Intranet websites on the computer. 

If installed on a computer with FactoryTalk View SE software components, the Internet Explorer ESC can interfere 
with the ability of FactoryTalk View SE Clients to connect to application servers. 

To avoid unexpected behavior, it is recommended that you remove the ESC from computers running FactoryTalk 
View SE. 

To remove ESC in Windows Server 2012 or 2016: 
1. On the Windows taskbar, select the Server Manager icon. 
2. In the Server Manager Dashboard window, on the left side, click Local Server. 
3. On the right side of the Local Server window, under Properties, locate IE Enhanced Security Configuration 

and click On. 
4. In the Internet Explorer Enhanced Security Configuration dialog box, select Off to turn off IE Enhanced 

Security for Administrators and for Users, and then click OK. 

Set up Data Execution Prevention 
Data Execution Prevention (DEP) is a Microsoft Windows security feature that is built into the operating system 
starting with Windows XP and Windows Server 2003. DEP is intended to protect programs and services from 
viruses and other security threats. 
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The DEP settings determine which programs and services are covered by DEP protection. On computers running 
FactoryTalk View SE components, it is recommended that DEP be turned on for essential Windows programs and 
services only. 

To turn on DEP: 
1. Open Windows Control Panel, and then select System and Security > System. 
2. Under Related settings on the left, select Advanced system settings. 
3. On the Advanced tab of the System Properties dialog box, under Performance, click Settings. 
4. In the Performance Options dialog box, click the Data Execution Prevention tab. 
5. Select Turn on DEP for essential Windows programs and services only, and then click OK. 

Remove unnecessary DCOM networking protocols 
If multiple DCOM protocols are installed and configured on the computer, performance of communications in a 
FactoryTalk View SE system can be adversely impacted. To ensure that DCOM communications function correctly, 
and do not affect the performance of the system, remove all protocols other than TCP/IP. 

To remove unnecessary DCOM protocols: 
1. Select Start > Run. 
2. In the Run dialog box, type dcomcnfg, and then click OK. 
3. In the Component Services tool, expand Component Services, open the Computers folder, right-click My 

Computer, and then select Properties. 
4. Click the Default Protocols tab. If the DCOM Protocols list shows protocols in addition to TCP/IP, remove 

those unnecessary protocols. For example, remove the protocol Connection-oriented SPX. 
 





 

 Rockwell Automation Publication VIEWSE-IN003S-EN-E - March 2022 25 
 

Chapter 4 

Install FactoryTalk View 

Install FactoryTalk View to develop and run distributed systems involving multiple computers on a network, or local 
applications confined to a single computer using FactoryTalk View SE. 

To learn about upgrading an existing version of FactoryTalk View SE, see Upgrade an operating FactoryTalk View 
SE application on page 43. 

To learn about modifying or uninstalling the FactoryTalk View software, see Modify or uninstall FactoryTalk View 
on page 31. 

Steps 
FactoryTalk View supports the Setup wizard installation and command-line installation. 

Setup wizard installation 

This chapter uses the Setup wizard to show the installation process, includes: 

• Step 1: Prepare for the installation on page 25 
• Step 2: Start the installation on page 27 
• Step 3: Post-installation procedures on page 28 

In a distributed system, you can also install Site Edition clients through the web browser. For instructions, see 
Install SE clients in a distributed system on page 30. 

Command-line installation 

In the command-line installation, you type a specified command line with multiple parameters. During the 
installation process, instead of prompting you for installation and configuration information interactively, the 
process follows the parameters specified in the command lines and completes the installation silently. For more 
information, see Use command-line installation on page 71. 

Step 1: Prepare for the installation 
Before the installation, you need to decide which components to install. 

The Setup wizard offers the following options for FactoryTalk View SE applications: 

• Studio Enterprise 
• Site Edition Server 
• Site Edition Client 
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• Site Edition Station 
• FactoryTalk ViewPoint SE 
• Stand-alone FactoryTalk Linx Server 
• Stand-alone FactoryTalk Directory Server 

The option you choose depends on the type of FactoryTalk View SE application or software component you plan to 
run on the computer and on the design of your control system. 

For each selection on the Setup screen, the following table shows the mandatory, recommended and optional 
software components to install. 

Selected Application Mandatory Recommended  Optional 

Studio Enterprise Studio Enterprise 
Site Edition Client1 
FactoryTalk Services Platform 
FactoryTalk Activation Manager 
FactoryTalk Alarms and Events 
FactoryTalk Linx 

Site Edition Server 
FactoryTalk ViewPoint SE 
FactoryTalk ViewPoint ME 

FactoryTalk Historian Connectivity2 
FactoryTalk Updater Agent3 

Site Edition Server Site Edition Server 
FactoryTalk Services Platform 
FactoryTalk Activation Manager 
FactoryTalk Alarms and Events 
FactoryTalk Linx 

 Site Edition Client 
FactoryTalk Updater Agent 

Site Edition Client Site Edition Client 
FactoryTalk Services Platform 
FactoryTalk Activation Manager 
FactoryTalk Alarms and Events 

 FactoryTalk Historian Connectivity 
FactoryTalk Updater Agent 

Site Edition Station Site Edition Server 
Site Edition Client 
FactoryTalk Services Platform 
FactoryTalk Activation Manager 
FactoryTalk Alarms and Events 
FactoryTalk Linx 

Studio Enterprise 
FactoryTalk ViewPoint SE 

FactoryTalk Historian Connectivity 
FactoryTalk Updater Agent 

FactoryTalk ViewPoint SE FactoryTalk ViewPoint SE 
Site Edition Client 
FactoryTalk Services Platform 
FactoryTalk Activation Manager 
FactoryTalk Alarms and Events 

 FactoryTalk Historian Connectivity 
FactoryTalk Updater Agent 

Stand-alone FactoryTalk Linx 
Server 

FactoryTalk Linx 
FactoryTalk Services Platform 
FactoryTalk Activation Manager 
FactoryTalk Alarms and Events 

 FactoryTalk Updater Agent 

Stand-alone FactoryTalk 
Directory Server 

FactoryTalk Services Platform 
FactoryTalk Activation Manager 

 FactoryTalk Updater Agent 

1. Site Edition Client is not mandatory if you do not plan to install FactoryTalk ViewPoint SE. 
2. For more information about FactoryTalk Historian Connectivity, see About FactoryTalk Historian Connectivity on page 27. 
3. For more information about FactoryTalk Updater Agent, see Common upgrade procedures on page 65. 
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About FactoryTalk Historian Connectivity 
FactoryTalk Historian Connectivity allows the trending objects to retrieve data from a Historian SE Server or 
FactoryTalk Historian ME Module. It makes updates to FactoryTalk Administration Console and FactoryTalk View 
SE Studio to display an Historian icon for FactoryTalk Historian SE when registered. You can use it to create new 
FactoryTalk Historian SE points from trending objects, and select existing Historian points from Historian SE or 
Historian ME. 

To trend data points from the FactoryTalk Historian SE server, FactoryTalk Historian ME model, or OSIsoft® PI 
Server™, FactoryTalk Historian Connectivity must be installed as a minimum required component with Site Edition 
Client or Studio Enterprise. 

 
Tip: You cannot install FactoryTalk Historian Connectivity on top of FactoryTalk Historian SE. 

Before you start using the trending objects with your FactoryTalk Historian SE server, do the following: 

• Add the FactoryTalk Historian SE server to the same FactoryTalk Directory as FactoryTalk View SE 
computers. 

• Create a mapping or trust for security between FactoryTalk View SE and FactoryTalk Historian SE. 

For detailed instructions, see FactoryTalk View SE TrendX and TrendPro in FactoryTalk Historian SE Installation and 
Configuration Guide. 

Step 2: Start the installation 
To start the installation: 

1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. Follow the on-screen instructions. 
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IMPORTANT If you install Studio Enterprise, Site Edition Server, or FactoryTalk 
ViewPoint SE on a computer with no FactoryTalk View component installed, 
the installation enables HTTPS by default. You can select Customize to 
disable HTTPS. 
For secure communication, HTTPS protocol is recommended. If HTTPS is 
enabled, you must configure a TLS certificate after installation. If you do not 
configure the certificate, there will be unexpected errors when operating 
FactoryTalk View SE components. For details, see Configure a TLS certificate 
on page 29. 
With HTTPS enabled, port 443 is used by default. However, if port 443 is 
already in use by other web applications (such as Node.js web server), this will 
cause a port conflict. To avoid the port conflict, after the installation, change 
the port number used by FactoryTalk View SE in: 
• Site binding in Internet Information Services (IIS) Manager  
• FactoryTalk View SE's HTTPS protocol properties in FactoryTalk 

Administration Console 
If you want to install a FactoryTalk View SE component on a computer 
installed with any FactoryTalk View SE component, the installation will keep 
the original settings. 

FactoryTalk Batch View HMI controls are installed with Site Edition Client and Studio Enterprise by default. 

4. When the installation completes: 

• To activate now, use the serial number and product key. 
• To activate later, use the activation file. 

For more information about activation, see FactoryTalk Activation Manager Help. 

Step 3: Post-installation procedures 
After you install FactoryTalk View, there may be several final setup steps that must be completed: 

• Specify the Network Directory server location on page 28 
• Configure a TLS certificate on page 29 
• Install product updates on page 65 

Specify the Network Directory server location 
After installing FactoryTalk software, specify one of the computers on the network as the Network Directory server, 
and then point the other computers on the network to that computer. This allows all of the computers on the 
network to share FactoryTalk Network Directory services and resources. 

To configure the Network Directory Server computer: 
1. On the computer that you want to use as the Network Directory Server, select Start > Rockwell Software > 

Specify FactoryTalk Directory Location. 

 
Tip: You will have to log on as an administrator on the computer. 

2. In the FactoryTalk Directory Server dialog box, 

• If localhost is not displayed in the field Computer hosting directory server, click the Browse button. 
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• If localhost is displayed, the computer is already specified as the Network Directory host. You can close the 
utility. 

3. In the FactoryTalk Directory Server Configuration dialog box, select This computer and click OK. 
4. Click OK to close the utility. 

To configure the client and other application server computers: 
1. Select Start > Rockwell Software > Specify FactoryTalk Directory Location. 
2. Click the Browse button beside the field, Computer hosting directory server. 
3. In the FactoryTalk Directory Server Configuration dialog box, select Remote computer. 
4. Type the name of the Network Directory server computer, or click the Browse button to find and select the 

computer, and then click OK. 

 
Tip: You will have to log on as an administrator on the computer. 

5. Click OK again to close the utility. 
6. Repeat steps 1 to 5 on the remaining client and server computers that will participate in the deployed network 

distributed application. 

Configure a TLS certificate 
If you have enabled HTTPS during the installation, configure a Transport Layer Security (TLS) certificate on the 
HMI server, FactoryTalk View Studio, and FactoryTalk ViewPoint SE server computers. 

Certificates from your organization's internal Certificate Authority (CA) and a commercial CA are supported. If you 
want to use a commercial certificate, you need to obtain it by sending a request to a CA. Once you have a certificate, 
install it on all HMI server and FactoryTalk View Studio computers. 

The steps may vary on different operating systems. Follow the on-screen instructions that apply to the operating 
system you are using. This instruction uses Windows 10 as an example. 

To install a TLS certificate: 
1. On the HMI server, FactoryTalk View Studio, and FactoryTalk ViewPoint SE server computers, open Internet 

Information Services (IIS) Manager. 

 
Tip: The Setup wizard detects and installs IIS automatically if IIS is not available on the 
computer. 

2. Under IIS, double-click Server Certificates. 
3. In the Actions pane: 

• If you have a PFX file containing the certificate (public keys) and the corresponding private keys, click 
Import. 

• If you have a file received from a CA containing the CA's response (a CER file, for example), click Complete 
Certificate Request. 

4. Add the certificate. 

• If you selected Import: 

a. In the Import Certificate dialog box, click the browse button. 
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b. Navigate to the PFX file, and then click Open. 
c. Enter the password. 
d. Click OK. 

• If you selected Complete Certificate Request: 

a. On the Specify Certificate Authority Response page, click the browse button. 
b. Navigate to certificate file, and then click Open. 
c. Enter a name for the certificate in the Friendly name box. 
d. Click OK. 

After installing the certificate, make sure the TLS certificate is selected for the HTTPS site binding. 

To select a TLS certificate for the HTTPS site binding: 
1. On the HMI server and FactoryTalk View Studio computers, in the Connections pane of Internet 

Information Services (IIS) Manager, go to the server and site that the certificate binds to. 
2. In the Actions pane, click Bindings. 
3. In the Site Bindings dialog box, select the HTTPS site binding, and then click Edit. 
4. From the SSL certificate list, select the desired certificate. 
5. Click OK. 

Install SE clients in a distributed system 
In a distributed system, after installing the server computer with the Client Install Portal feature, you can install SE 
clients through the web browser. 

To install the SE client application: 
1. On the client computer, open Internet Explorer. 
2. In the Address field, type http://servername/ftviewclient where servername is the computer name of your 

FactoryTalk View SE server. 

 
Note: If you are using TLS, begin with https:// instead. 
The web page may not be opened if you enable HTTPS on the IIS server and your client is on 
another computer. You need to configure the client to access the server. To do this, export 
the server certificate and import the certificate to the client computer. For detailed 
instructions on exporting and importing server certificates, see Microsoft TechNet. 

3. Press Enter. Internet Explorer displays a page from the server that allows you to install the FactoryTalk View 
Site Edition Client application. 

 
Tip: If Internet Explorer displays an error message that it cannot connect to the install web 
page, try adding the FactoryTalk View Site Edition website (URL above) to your local intranet 
site list. 
To do this, in Internet Explorer, click Tools > Internet Options > Security tab > Local 
intranet > Sites > Advanced, and add the website to the list. For more information about 
the local intranet, refer to Windows Help and Support. 

4. Microsoft .NET Framework 4.0 or higher is required before you can install FactoryTalk View Client. If it is not 
installed, FactoryTalk View installs .NET Framework 4.8 by default. 

5. Follow the on-screen instructions. If prompted to restart your computer, click Restart Now. 
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6. Once the computer has restarted, repeat steps 1 to 4. 
7. To install SE Client, click Install FactoryTalk View Site Edition Client on this computer. Follow the on-screen 

instructions.  

If you are displaying data from FactoryTalk Historian on trends, click Install FactoryTalk Historian 
Connectivity tools. Follow the on-screen instructions to complete the installation. For more information 
about FactoryTalk Historian Connectivity, see About FactoryTalk Historian Connectivity on page 27. 

Modify or uninstall FactoryTalk View 
To modify components of FactoryTalk View, from the installation package, double-click Setup.exe, select one 
product and click Modify. 

To uninstall FactoryTalk View, do one of the following: 

• From the installation package, double-click Setup.exe, select one product and click Uninstall. 
• From Programs and Features of Windows Control Panel, right-click the installed FactoryTalk View product 

and select Uninstall. 
• From the Command Prompt window, type a command with the following syntax: 

Setup.exe [/Q | /QS] /Uninstall /Product=product_name 
Components, such as FactoryTalk Activation Manager, that are shared with other products will not be 
uninstalled. For more information about command-line parameter, see Command-line parameters on page 
71. 
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Chapter 5 

Activate FactoryTalk View software 

To activate FactoryTalk View SE, use the FactoryTalk Activation Manager installed with FactoryTalk View. 

About FactoryTalk Activation Manager 
FactoryTalk Activation services provide a secure, software-based system for activating Rockwell Software products 
and managing software activation files. 

FactoryTalk View SE products use two types of activations: 

• Floating concurrent activations are checked out of an activation server located on the network, and require a 
continuous network connection. 

• Borrowed concurrent activations are time-expiring activations checked out of an activation server on the 
network, and do not require a continuous network connection. 

For standard installations of the product software, FactoryTalk View SE does not support node-locked activations. 

For more information, see the FactoryTalk Activation Manager Help. 

What happens if FactoryTalk View is not activated? 
If the FactoryTalk View components are not activated, the software will continue to run for up to seven days. After 
the grace period expires, if you restart FactoryTalk View SE and activation remains unavailable, the software will run 
for two hours in demo mode. 

When running in demo mode, there are some limitations. 

• You can run a local station FactoryTalk View application for up to two hours. 
• Remote clients cannot connect to a FactoryTalk View server. 

Starting from FactoryTalk View version 10.00, some limitations are eliminated. You can create or load over five 
graphic displays per HMI server now. You can also fully use the Symbol Factory library without restriction. 

Activation keys for FactoryTalk View software components 
The activation files you download from the Rockwell Software Activation Website contain the activation keys you 
purchased, in encrypted form. The activation key is the software that activates FactoryTalk View SE components. 

Following is a list of activation keys used by the FactoryTalk View SE and ME products. For information about the 
keys required to activate other Rockwell Automation products in your application, see the product documentation. 
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To activate this software product or component Use this key 

FactoryTalk View Studio* 
*Includes software for developing and testing FactoryTalk View Site Edition and Machine Edition applications 

RSV.STUDIO 

FactoryTalk View SE Server (network distributed applications), unlimited displays RSVSESRV.MAX 

FactoryTalk View SE Server (network distributed applications), 250 displays RSVSESRV.250 
FactoryTalk View SE Server (network distributed applications), 100 displays RSVSESRV.100 
FactoryTalk View SE Server (network distributed applications), 25 displays RSVSESRV.25 

FactoryTalk View SE Redundancy Server (network distributed applications), unlimited displays FTVSERED.MAX 

FactoryTalk View SE Redundancy Server (network distributed applications), 250 displays FTVSERED.250 
FactoryTalk View SE Redundancy Server (network distributed applications), 100 displays FTVSERED.100 

FactoryTalk View SE Redundancy Server (network distributed applications), 25 displays FTVSERED.25 

FactoryTalk View SE Client (network distributed applications), read and write RSVSECLI.RW 

FactoryTalk View SE Client (network distributed applications), view only RSVSECLI.RO 

FactoryTalk View SE Station (network station and local station applications), unlimited displays RSVSE.MAX 

FactoryTalk View SE Station (network station and local station applications), 250 displays RSVSE.250 
FactoryTalk View SE Station (network station and local station applications), 100 displays RSVSE.100 
FactoryTalk View SE Station (network station and local station applications), 25 displays RSVSE.25 
FactoryTalk View SE Station (network station and local station applications), 15 displays RSVSE.15 

 

Sharing keys among multiple software components 
Multiple FactoryTalk View SE software components can function using one activation key in the following cases: 

• Multiple instances of FactoryTalk View Studio or the FactoryTalk View SE Client running on the same 
computer can use a single key (RSV.STUDIO or RSVSECLI), as long as the components are not running in a 
Terminal Services or a Remote Desktop Services session. However, within that single Terminal Services or a 
Remote Desktop Services session, the client activation key is sharable. 

 
Tip: Starting from FactoryTalk View SE version 11.0 and ThinManager version 11.0, a single 
FactoryTalk View SE Client license is required per ThinManager-managed terminal. This 
allows you to deliver an unlimited number of sessions (either for ThinManager MultiSession 
or Failover) and consume only that one SE Client license per ThinManager-managed 
terminal. 

• Local applications use a single key (RSVSE.*) to activate both the FactoryTalk View SE Client and the 
FactoryTalk View SE Server at runtime. These components running together are also known as FactoryTalk 
View SE Station. To run multiple station client instances on the same server computer, make sure to launch 
the clients first and then the server. Otherwise, two activation keys may be required. 

 
Tip: FactoryTalk View SE Server activations—known as capacity activations because they 
are based on the number of displays in an application—cannot be shared. 

• If you want to switch from a station application to a network distributed application, use the original station 
key to activate the remote display client in the network distributed application. 
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Read-write versus view-only activations 
In a network application, FactoryTalk View SE Clients can use two types of activation: 

• Read-write keys (RSVSECLI.RW) allow full read-write privileges. 
• View-only keys (RSVSECLI.RO) allow view-only privileges. 

The type of license obtained by the client decides whether a FactoryTalk View SE Client runs in read-write or in 
view-only mode. 

Do not rely on available activation keys to determine whether the FactoryTalk View SE Client runs in read-write or 
view-only mode. Instead, to ensure that a client always runs in view-only mode, choose the view-only option when 
setting up the client's configuration file. For details, click Help in the FactoryTalk View SE Client wizard. 
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Chapter 6 

Deploy applications 

After you finish developing and testing a FactoryTalk View Site Edition application, you can deploy it to run in a live 
setting, such as the plant floor. 

This chapter shows the steps of deploying network distributed applications, network station applications, and local 
station applications. Most steps are common for the three types of applications. Those that are unique to a certain 
application are marked with a note. 

Step 1: Move the application 
Two steps are involved in moving an application: 

• On the development computer, back up the application. 
• On the production computer, restore the application archive. 

 
Tip: Before backing up an application, record the user names and passwords of 
administrative users set up for the application, in case you need this information after 
restoring the application. 

To back up an application on the development computer 
1. Select Start > Rockwell Software > FactoryTalk View SE Application Manager. 

 
Tip: The logged on user must have the Backup and restore directory contents 
permission. For more information, see FactoryTalk Security Help or check with your System 
Administrator. 

2. On the Create a Backup tab, select your application and follow the wizard to back up the application. 
3. Copy the .apb file to the production computer. 

If you are restoring an application on a computer that contains a copy of the original application, use FactoryTalk 
View SE Application Manager to delete or rename the original application, before you begin the restore operation. 

To restore an application on the production computer 
1. (optional) If you are restoring a network distributed application, make sure that all client and server 

computers in the application point to the same FactoryTalk Directory server. 

a. Select Start > Rockwell Software > Specify FactoryTalk Directory Location. 

b. Click the Browse button beside the field, Computer hosting directory server. 

c. In the FactoryTalk Directory Server Configuration dialog box, click Remote computer. 

You will have to log on as an administrator on the computer. 
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d. Click OK. 

2. Select Start > Rockwell Software > FactoryTalk View SE Application Manager. 

 
Tip: The logged on user must have the Backup and restore directory contents 
permission. For more information, see FactoryTalk Security Help or check with your System 
Administrator. 

3. In the Restore an Archive tab, specify the restore options and follow the wizard. 

Step 2: Move the application’s data server files 
Ensure that the required communications software (for example, FactoryTalk Linx, RSLinx Classic, or other OPC 
software) is installed on computers that will run data servers. 

Then, if necessary, for the data servers you are deploying, move configuration files to the production computers, and 
then specify the new host computer names. 

 
Tip: For information about moving setup files for OPC data servers, see the product documentation 
for the OPC server. 

 

Step 3: Renew data server shortcuts and device paths 
After restoring FactoryTalk Linx data servers in the application, renew or verify the shortcuts and device paths 
associated with each data server, as needed. 

If you are restoring redundant data servers, then the device paths must be confirmed and reapplied for both the 
primary and the secondary server. 

To renew FactoryTalk Linx device paths: 
1. Open the restored application in the FactoryTalk Administration Console. 
2. In the Explorer window, expand the data server (FactoryTalk Linx), and then double-click Communications 

Setup. 
3. In the Communications Setup editor, select each configured FactoryTalk Linx shortcut, point the shortcut at 

the correct device, and then click Apply. 
4. Save the configuration, and then close the Communications Setup editor. 

Step 4: Set up additional HMI server properties 
After restoring the application, open the HMI server properties dialog box in FactoryTalk View Studio to verify the 
HMI server settings and set up additional HMI server properties as needed. 

According to the application type, you can: 

• Specify startup components 
• Specify the startup type (only applicable for network distributed applications) 
• Set up redundancy (only applicable for network distributed applications) 
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If you are deploying a network distributed application, you must set up the HMI server properties separately for 
each server in the system. You can do this on the computer running the HMI server or from a remote computer. 

To open the HMI Server Properties dialog box: 
1. Select Start > FactoryTalk View Studio. 
2. In the Application Type Selection dialog box, select the application type and click Continue. 
3. On the Existing tab, select the application and click Open. 
4. In the Explorer window, right-click the HMI server and select Properties. 

Specify startup components 
On the Components tab, select the application components that will start automatically when the HMI server starts, 
and select the macro that will run when the server shuts down. You can also start or stop components manually. 

For a network distributed application, if the HMI server is redundant, you can also start and stop components for 
the primary and the secondary server, and select On active and On standby macros. 

Specify the startup type 
 

Note: This topic only applies to when you deploy network distributed applications. 

On the General tab, you can specify that the HMI server will load when the first client attempts to connect to it (On 
demand) or when the host computer starts up (Load and run startup components when operating system 
initializes). The second option is recommended for production HMI servers, and required for an HMI server that is 
part of a redundant pair. 

Set up redundancy 
 

Note: This topic only applies to when you deploy network distributed applications. 

On the Redundancy tab, select Provide redundancy using a secondary server, specify the name the computer that 
will host the secondary server, and select a switchover option. 

After you apply the settings, FactoryTalk View SE automatically copies HMI project information from the primary 
server to the secondary server. 

Synchronize redundant HMI servers and projects 
At runtime, you can make changes to the HMI project components in an application while it is running. For 
example, you can add, modify or delete graphic displays and other components, and have those changes to take 
effect at connected clients. 

To automatically save the project online edits to both active and standby servers, in FactoryTalk View Studio, from 
the menu, select Tools > Options. On the Settings tab, make sure the Save edits to both active and standby HMI 
servers option is selected. To keep the HMI memory tag values the same on both active and standby servers, on the 
same tab, select the Auto synchronize HMI memory tag values to both active and standby HMI servers option. 
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If you do not set up the option, manually replicate the changes from the active server to standby server. The replicate 
operation copies the current active server’s configuration files, including settings in the Components tab, to the 
standby server. 

For example, if an On Active and a Shutdown macro are selected for the Active server, the settings will be replicated 
to the Standby server. This means that the same macros specified for the Active server will run when the Standby 
server becomes active or shuts down. Information that is not included in the replicate operation includes datalog 
files generated at runtime, the current value of HMI memory tags, and retentive tags. 

 
Note: Make sure to verify the current HMI server name and status before the replication. 

To manually replicate the changes: 
1. In the FactoryTalk View Studio Explorer window, right-click the HMI server and select Server Status. 
2. In the Server Status dialog box, verify that the current HMI server status is Active and the other is Standby. 

 
Tip: To show the status of the HMI servers, FactoryTalk Alarm and Event servers, and data 
servers at runtime, add one of the following to the application: 
• A Server Status display under the Library folder. 
• A redundancy function, such as PrimaryServerStatus and SecondaryServerStatus. 

3. In the HMI Server Properties dialog box, in the Redundancy tab, click Replicate Active to Standby. 

Step 5: Set up the FactoryTalk View SE Client 
The FactoryTalk View Site Edition client provides a complete runtime operating environment that can run on 
remote client computers. 

When using a network station or local station application, the FactoryTalk View SE Client must run on the same 
computer as the HMI server. 

If you have already set up a FactoryTalk View SE Client file for the application, you can copy the file to the 
production computer. Otherwise, you can create a new client file. 

Create a FactoryTalk View SE Client file 
The FactoryTalk View SE Client configuration file specifies the name of the application the client will connect to, the 
components that start when the connection is made, and how the client will behave at runtime. The file is with a .cli 
extension. 

 
Tip: It is not necessary to start the HMI server if you want to use the FactoryTalk View SE Client 
Wizard. 

To create a FactoryTalk View SE Client file: 
1. Select Start > Rockwell Software > FactoryTalk View Site Edition Client. 
2. In the FactoryTalk View SE Client Wizard, click Create a FactoryTalk View SE Client configuration file, and 

follow the on-screen instructions. For details about options in the wizard, click Help. 
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By default, auto logout is enabled for 10 minutes, which means the current logged-on user will be automatically 
logged out if there is no mouse or keyboard activity in 10 minutes. You can cancel this option on the FactoryTalk 
View SE Client Wizard's Advanced settings > Security and debugging tab. 

Lock operators into the runtime environment 
To lock operators inside the FactoryTalk View SE Client at runtime, for example, to prevent access to other programs 
on the computer, try one or more of the following methods: 

• Limit the ability to manipulate graphic displays, by removing the title bar or minimize and maximize 
buttons from selected displays. 

To do this, in the Display Settings dialog box, clear the check boxes Title Bar, Minimize Button, and 
Maximize Button. For details, see Creating graphic displays in the FactoryTalk View Site Edition User’s Guide. 

• Limit the ability to manipulate the client window, by removing the title bar or minimize and maximize 
buttons from the client. 

To do this, in the FactoryTalk View SE Client wizard, clear the check boxes, Show title bar, and Show system 
menu and close button. For details, click Help in the FactoryTalk View SE Client wizard. 

• Prevent switching to other applications. To do this, in the FactoryTalk View SE Client wizard, select the 
check box, Disable switch to other applications. For details, click Help in the FactoryTalk View SE Client 
wizard. 

• Restrict access to the desktop, using the DeskLock tool. 

To open Desklock, on the desktop select Start > Rockwell Software > DeskLock. 
For details about using DeskLock, click Help within the tool. 

 
Note: Do not enable DeskLock until you read the help for the tool and understand how it 
works. Otherwise, you could end up locking yourself out of the desktop. 

• Restrict access to system files via the Windows file explorer when saving the trace data or captured image of 
TrendPro and XY Plot. 

To do this, use the CustomFileExplorer VBA property by setting it to True. When saving the trace data or 
captured image, the custom file explorer opens instead of the Windows file explorer. 

Copy existing FactoryTalk View SE Client files 
When setting up the FactoryTalk View SE Clients for a network distributed application, you can copy existing client 
files (.cli) from the development computer to the client production computers. 

You can run the client configuration from the desktop, or from any other location on the client computer. 

By default, client configuration files are saved on the desktop. 

Step 6: Run the FactoryTalk View SE Client 
Once the application is deployed, test it by running the FactoryTalk View SE Client. 
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Note: To connect a FactoryTalk View SE Client to a network distributed application, all client and 
server computers in the application must point at the same FactoryTalk Network Directory server. 
For details, see Specify the Network Directory server location on page 28. 

To run an SE Client from FactoryTalk View Studio: 
• In FactoryTalk View Studio, on the Tools menu, click Launch SE Client. 

To run an SE Client when Windows starts: 
1. Create a shortcut to the.cli file (on the desktop, for example). 
2. Move the shortcut to the Windows Startup folder. 

For information about adding shortcuts to the Startup folder, see the Windows Help. 

Administer deployed applications 
To make changes to an application after it is deployed, use FactoryTalk View Studio. 

To do this in FactoryTalk View Studio Use this editor 

Change the properties of an HMI server. HMI Server Properties 
Change the properties of a data server. Data Server Properties 
Add FactoryTalk users to an application. Runtime Security 
Set up security for commands and macros. Secured Commands 
Run FactoryTalk View commands. Command Line 
Change the paths of data log models. Data Log Paths 
Import and export HMI tags. Tag Import and Export Wizard 

For details about these editors or more administrative operations, see FactoryTalk View SE Help. 
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Chapter 7 

Upgrade operating network distributed applications 

Upgrading the FactoryTalk View Site Edition software in an automation and control application involves two core 
tasks: uninstalling the existing software and then installing the new version. 

 
Tip: Applications developed on versions 6.0 and earlier may need to be converted using the Legacy 
Tag Database Conversion utility. To start the utility, select Start > Rockwell Software, right-click 
Legacy Tag Database Conversion and select Run as administrator. For details about using the 
utility, click Help. 

Depending on the design, content, and complexity of your control system, you might have to perform additional 
tasks to support the upgrade, especially if you are upgrading FactoryTalk View SE in a production environment. 

The upgrading steps vary depending on your application: 

• Upgrade a non-redundant network distributed application on page 43 
• Upgrade a redundant network distributed application on page 48 

As there are many possible variations for this type of application, parts of the documented process might not apply 
directly to the application you are upgrading. If you have questions about architectural elements not covered in this 
chapter, for example, your application is more or less complex than the example provided, contact your local 
Rockwell Automation Sales office for assistance. 

 
Tip: RSView Enterprise is the former name of the FactoryTalk View family of software products. If 
you are upgrading from a version of RSView, the information in this chapter still applies, even 
though it refers to FactoryTalk View as the previous product version. 

 

Upgrade a non-redundant network distributed application 
Use the following checklist as a guideline for upgrading your application. 

Part 1: Prepare for the upgrade 
• Step 1: Prepare for the upgrade on page 44 
• Step 2: Back up the deployed application on page 45 

Part 2: Perform upgrade of software components 
• Step 3: Shut down all client computers on page 45 
• Step 4: Upgrade the FactoryTalk Directory server on page 45 
• Step 5: Upgrade the HMI server on page 46 
• Step 6: Upgrade the data server on page 46 



 

44 Rockwell Automation Publication VIEWSE-IN003S-EN-E - March 2022  
 

• Step 7: Upgrade the engineering workstation on page 46 
• Step 8: Migrate the application on page 46 
• Step 9: Upgrade all runtime clients on page 47 
• Step 10: Test the migrated application on page 48 

Example 
The following illustration shows an example of a FactoryTalk View SE network distributed application without 
redundant servers. 

In this example, Workstation #1 is the name of the engineering workstation. Assume that: 

• The FactoryTalk Directory server, HMI server, and data server are hosted on different computers. 
• The Tag Alarm and Event server and HMI server are hosted on the same computer. 

 

Part 1: Prepare for the upgrade 

Step 1: Prepare for the upgrade 
Use the following multi-step checklist as a guideline when you prepare for the upgrade. 

• Log on with administrative rights on page 44 
• Record the names and passwords of administrative users on page 45 
• Perform set-up tasks on application computers on page 45 

Log on with administrative rights 
Make sure the user performing the upgrade has administrative rights in Windows and at the FactoryTalk Network 
Directory. 
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• Windows administrative rights are required to install FactoryTalk View and supporting software. 
• FactoryTalk administrative rights are required to log on to the FactoryTalk Network Directory, back up and 

restore FactoryTalk View SE applications, etc. 

Record the names and passwords of administrative users 
Before backing up the deployed application, ensure that you have recorded the user names and passwords of users 
that belong to the FactoryTalk administrators group. 

Perform set-up tasks on application computers 
To ensure that FactoryTalk View SE runs smoothly after it is installed, review the chapter Hardware, operating 
system, and domain information on page 15. It describes hardware and software requirements, application limits, 
and tasks you can perform on application computers. 

Step 2: Back up the deployed application 
Before backing up the deployed application, ensure that the most recent application data is available for the upgrade 
at the FactoryTalk Network Directory. 

To back up the application on the HMI server 
1. Select Start > Rockwell Software > FactoryTalk View SE Application Manager. 

 
Tip: The logged on user must have the Backup and restore directory contents 
permission. For more information, see FactoryTalk Security Help or check with your System 
Administrator. 

2. On the Create a Backup tab, select your application and follow the wizard to back up the application. 

Part 2: Perform upgrade of software components 

Step 3: Shut down all client computers 
To disconnect the clients from the servers, shut down all runtime client computers, server computers, and 
Workstation #1. 

 

Step 4: Upgrade the FactoryTalk Directory server 
1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Stand-alone FactoryTalk Directory Server and click Install Now. 

 
Tip: If you host the FactoryTalk Network Directory, HMI server, and data server on the same 
computer, select Studio Enterprise, and skip to Step 7: Upgrade the engineering 
workstation on page 46. 
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4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 
25. 

5. After installation, install any necessary product updates. For more information, see Install product updates 
on page 65. 

Step 5: Upgrade the HMI server 
1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Site Edition Server and click Install now. 
4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 

25. 
5. After installation, install any necessary product updates. For more information, see Install product updates 

on page 65. 

Step 6: Upgrade the data server 
1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Stand-alone FactoryTalk Linx Server and click Install now. 
4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 

25. 
5. After installation, install any necessary product updates. For more information, see Install product updates 

on page 65. 

Step 7: Upgrade the engineering workstation 
1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Studio Enterprise and click Install now. 
4. If you have FactoryTalk Historian Management Tools installed, you need to manually uninstall the 

Management Tools Suite and the System Management Tools before installing FactoryTalk Historian 
Connectivity. For more information, see Knowledgebase Document ID: QA25767 - FactoryTalk View SE v8.00 
(CPR 9 SR 7): The "FactoryTalk Historian Connectivity" option. 

5. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 
25. 

6. After installation, install any necessary product updates. For more information, see Install product updates 
on page 65. 

Step 8: Migrate the application 
Use the following checklist as a guideline when you migrate the FactoryTalk View SE application: 

• Open the application in FactoryTalk View Studio on page 47 
• Verify FactoryTalk Linx shortcuts on page 47 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/618193
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/618193
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• Test the migrated application on page 47 

Open the application 
To migrate the application, open it in the new version of FactoryTalk View Studio installed on upgraded 
Workstation #1. 

To open the application: 
1. Select Start > FactoryTalk View Studio. 
2. In the Application Type Selection dialog box, select the application type and click Continue. 
3. On the Existing tab, select the application and click Open. 
4. If prompted to convert the application the new version, click OK. 
5. Wait until the HMI server and all project components in the application are loaded, and then leave the 

application open in FactoryTalk View Studio. 

Verify FactoryTalk Linx shortcuts 
To confirm that data communications are set up correctly in the migrated application, verify that FactoryTalk Linx 
shortcuts point at the correct devices. 

To verify FactoryTalk Linx shortcuts: 
1. In FactoryTalk View Studio, expand the data server FactoryTalk Linx, and then double-click 

Communications Setup. 
2. In the Communications Setup editor, select each configured FactoryTalk Linx shortcut, and ensure that it 

points at the correct device. 
3. Save the configuration and close the Communications Setup editor. 

Test the migrated application 
To test the migrated application, run the application on Workstation #1. 

1. On Workstation #1, start a FactoryTalk View SE Client configuration. 
2. Ensure that data communications are functioning as expected. 

Step 9: Upgrade all runtime clients 
If you already have the Client Install Portal feature installed on the HMI server, you can upgrade the clients through 
a web browser. For detailed instructions, see Install SE clients in a distributed system on page 30. Otherwise, you 
can use the installation package. Follow the instructions below. 

1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Site Edition Client and click Install now. 
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4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 
25. 

5. After installation, install any necessary product updates. For more information, see Install product updates 
on page 65. 

Step 10: Test the migrated application 
To test the migrated FactoryTalk View SE application, perform these tasks: 

• Run the migrated application on upgraded clients on page 48 
• Verify that the system is functioning as expected on page 48 

Run the application on upgraded clients 
On each of the upgraded runtime client computers, run the existing FactoryTalk View SE Client configuration file 
(.cli). 

Verify that the system is functioning as expected 
After the application starts running on the upgraded client computers, verify that display navigation, object 
animation, communications, alarming (if configured), and other applications features are functioning as expected. 

Upgrade a redundant network distributed application 
Upgrading a redundant system can be done in parts, allowing you to keep your system running without redundancy 
temporarily while you upgrade. During an upgrade, a temporary system can help you with verification and 
validation. 

Use the following checklist as a guideline for upgrading your application. 

Part 1: Prepare for the upgrade 
• Step 1: Prepare for the upgrade on page 49 
• Step 2: Back up the application on Server #1 on page 50 

Part 2: Set up a separate system and perform a partial upgrade 
• Step 3: Set up a temporary upgrade system on page 51 
• Step 4: Upgrade Server #2 on page 53 
• Step 5: Upgrade Workstation #1 on page 54 
• Step 6: Migrate the application on page 54 
• Step 7: Upgrade selected runtime clients on page 55 
• Step 8: Test the migrated application on page 56 

Part 3: Upgrade remaining computers and restore redundancy 
• Step 9: Upgrade remaining client computers on page 56 
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• Step 10: Upgrade Server #1 on page 57 
• Step 11: Restore redundancy and finish upgrading on page 58 

Example 
The following illustration shows an example of a FactoryTalk View SE network distributed application with 
redundant servers. 

In this example, Server #1 is the name of the primary server computer, Server #2 is the name of the secondary server 
computer, and Workstation #1 is the name of the engineering workstation. Assume that: 

• The FactoryTalk Directory server, primary data server, primary HMI server, and primary Tag Alarm and 
Event server are located on Server #1. 

• The secondary data server, secondary HMI server, and secondary Tag Alarm and Event server are located on 
Server #2. 

 

Part 1: Prepare for the upgrade 

Step 1: Prepare for the upgrade 
Use the following multi-step checklist as a guideline when you prepare for the upgrade. 

• Log on with administrative rights on page 50 
• Record the names and passwords of administrative users on page 50 
• Perform set-up tasks on application computers on page 50 
• Ensure that the latest application files are on the primary server on page 50 
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Log on with administrative rights 
Make sure the user performing the upgrade has administrative rights in Windows and at the FactoryTalk Network 
Directory. 

• Windows administrative rights are required to install FactoryTalk View and supporting software. 
• FactoryTalk administrative rights are required to log on to the FactoryTalk Network Directory, back up and 

restore FactoryTalk View SE applications, etc. 

Record the names and passwords of administrative users 
Before backing up the deployed application, ensure that you have recorded the user names and passwords of users 
that belong to the FactoryTalk administrators group. 

Perform set-up tasks on application computers 
To ensure that FactoryTalk View SE runs smoothly after it is installed, review the chapter Hardware, operating 
system, and domain information on page 15. It describes hardware and software requirements, application limits, 
and tasks you can perform on application computers. 

Ensure that the latest application files are on the primary server 
During the upgrade, the application and HMI project files backed up on the primary server are restored on the 
secondary server, and then migrated in FactoryTalk View Studio on the upgraded engineering workstation. 

To migrate and re-deploy the most recent application, ensure that the application and HMI project files you back up 
initially, on the primary server, are the most recent application files. 

Step 2: Back up the application on Server #1 
Before backing up the deployed application, ensure that the most recent application data is available for the upgrade 
on Server #1. 

Use the FactoryTalk View SE Application Manager tool to back up the application. The backup archive has an .APB 
extension, and includes all FactoryTalk Directory data, such as accounts, passwords, policies and security settings. It 
also includes all application contents like application configurations, HMI servers, data servers, and tag Alarm and 
Event servers. 

To back up the application: 
1. On Server #1, select Start > Rockwell Software > FactoryTalk View SE Application Manager. 

 
Tip: The logged on user must have the Backup and restore directory contents 
permission. For more information, see FactoryTalk Security Help or check with your System 
Administrator. 

2. In the Create a Backup tab, select your application and specify the Host Machine as Server #1. 
3. Follow the wizard to back up the application on Server #1. For more instructions, see FactoryTalk View SE 

Application Manager Help. 
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Part 2: Set up a temporary system and perform a partial upgrade 
During this part, a temporary system is set up to test a partial upgrade that involves Server # 2, Workstation #1, and 
selected runtime clients. For the test, Server #2 is set up to function as the primary server. 

 
Tip: It is recommended that you upgrade the software on some application clients, confirm that the 
upgraded application is running as expected, and then upgrade the software on the remaining 
clients. The number of clients to upgrade initially is left to your discretion. 

 

Step Description 

1 First, set up Server #2 as the Network Directory and 
primary HMI and data server (without redundancy). Then, 
upgrade the software on Server #2. 

2 Next, upgrade the software components on Workstation 
#1, and then migrate the restored application. 

3 Finally, upgrade the software components on some 
runtime clients only, and then test the partial upgrade. 

 

Step 3: Set up a temporary upgrade system 
As part of the process, the original HMI project and application files that were backed up on Server #1 are restored 
on Server #2. The restored application will be migrated later, after Workstation #1 is upgraded. 

 
Note: To avoid introducing incompatible software component versions into a deployed production 
system, be sure to restore the HMI project and application files before upgrading any software. 

To set up a temporary system so that you can test a partial upgrade, perform the tasks below. 

• Disable HMI and data server redundancy in the original application on page 52 



 

52 Rockwell Automation Publication VIEWSE-IN003S-EN-E - March 2022  
 

• Copy the archive file to Server #2 on page 52 
• Specify Server #2 as the Network Directory location on page 52 
• Restore the application on Server #2 as the primary server on page 52 
• Specify Server #2 as the Network Directory location for Workstation #1 on page 53 
• Disable redundancy on Server #2 on page 53 
• Disable alarm and event history logging on page 53 

Disable HMI and data server redundancy in the original application 
To ensure that Server #2 can be detached from the application for upgrading, open the application in FactoryTalk 
View Studio, and disable redundancy for the HMI server and data server. 

To disable HMI and data server redundancy: 
1. On Workstation #1, open the application in FactoryTalk View Studio. 
2. In the Explorer window, right-click the HMI server and select Properties. 
3. In the Redundancy tab, clear the check box Provide redundancy using a secondary server, and click OK. 
4. In the Explorer window, right-click the data server FactoryTalk Linx and select Properties. 
5. In the Redundancy tab, clear the check box Provide redundancy using a secondary server, and click OK. 

Copy the archive file to Server #2 
Move the archive file (*.apb) created on Server #1 to Server #2. 

 

Specify Server #2 as the Network Directory location 
1. On Server #2, select Start > Rockwell Software > Specify FactoryTalk Directory Location. 

 
Tip: To use the utility, you have to log on as an administrator on the local computer. 

2. Click the Browse button beside the field Computer hosting directory server. 
3. In the FactoryTalk Directory Server Configuration dialog box, select This computer and click OK. 

 
Tip: To change the Network Directory location, you have to log on as an administrator on 
the new Network Directory computer (local or remote). 

4. Click OK and then restart Server #2. 

Restore the application on Server #2 as the primary server 
1. On Server #2, select Start > Rockwell Software > FactoryTalk View SE Application Manager. 

 
Tip: The logged on user must have the Backup and restore directory contents 
permission. For more information, see FactoryTalk Security Help or check with your System 
Administrator. 

2. In the Restore an Archive tab, specify the restore scope as Restore application, with FactoryTalk Directory 
and the Primary Host as Server #2. 

3. Follow the wizard to restore the application. 
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Specify Server #2 as the Network Directory location for Workstation #1 
1. Select Start > Rockwell Software > Specify FactoryTalk Directory Location. 
2. Click the Browse button beside the field, Computer hosting directory server. 
3. In the FactoryTalk Directory Server Configuration dialog box, select Remote computer, type Server #2 and 

click OK. 

 
Tip: To change the Network Directory location, you have to log on as an administrator on 
the new Network Directory computer (local or remote). 

4. Click OK and then restart Workstation #1. 

Disable redundancy on Server #2 
1. On Workstation #1, open the restored application in FactoryTalk View Studio. 
2. In the Explorer window, right-click the HMI server and select Properties. 
3. In the Redundancy tab, clear the check box Provide redundancy using a secondary server, and click OK. 
4. In the Explorer window, right-click the data server FactoryTalk Linx and select Properties. 
5. In the Redundancy tab, clear the check box Provide redundancy using a secondary server, and click OK. 

Disable alarm and event history logging 
After you restore the application, the alarm and event history logging is also enabled on Server #2. It is 
recommended that you disable the history logging. Follow the steps below. 

1. On Workstation #1, open the restored application in FactoryTalk View Studio. 
2. In the Explorer window, right-click the Tag Alarm and Event server and select Properties. 
3. In the Priorities and History tab, clear the Enable history check box and click OK. 

If your system has controller device-based alarms, follow the steps below to disable the history logging. 

1. In the Explorer window, right-click the FactoryTalk Linx Data server and select Properties. 
2. In the Alarms and Events tab, clear the Enable history check box and click OK. 

Step 4: Upgrade Server #2 
To upgrade the software components, install FactoryTalk View SE and any necessary products updates on Server #2. 

1. On Server #2, close all open Windows programs. 
2. Double-click Setup.exe within the installation package. 
3. On the Setup page, select Site Edition Server and click Install now. 
4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 

25. 
5. After installation, install any necessary product updates. For more information, see Install product updates 

on page 65. 
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Step 5: Upgrade Workstation #1 
To upgrade the software components, install FactoryTalk View Studio and any necessary products updates on 
Workstation #1. 

1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Studio Enterprise and click Install now. 
4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 

25. 
5. After installation, install any necessary product updates. For more information, see Install product updates 

on page 65. 

Step 6: Migrate the application 
To migrate the FactoryTalk View SE application that was restored on Server #2, perform these tasks: 

• Open the application in FactoryTalk View Studio on page 54 
• Verify FactoryTalk Linx shortcuts on page 54 
• Test the migrated application on page 55 

Open the application 
To migrate the application, open it in the new version of FactoryTalk View Studio installed on upgraded 
Workstation #1. 

To open the application: 
1. Select Start > FactoryTalk View Studio. 
2. In the Application Type Selection dialog box, select the application type and click Continue. 
3. On the Existing tab, select the application and click Open. 
4. If prompted to convert the application the new version, click OK. 
5. Wait until the HMI server and all project components in the application are loaded, and then leave the 

application open in FactoryTalk View Studio. 

Verify FactoryTalk Linx shortcuts 
To confirm that data communications are set up correctly in the migrated application, verify that FactoryTalk Linx 
shortcuts point at the correct devices. 

To verify FactoryTalk Linx shortcuts: 
1. In FactoryTalk View Studio, expand the data server FactoryTalk Linx, and then double-click 

Communications Setup. 
2. In the Communications Setup editor, select each configured FactoryTalk Linx shortcut, and ensure that it 

points at the correct device. 
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3. Save the configuration and close the Communications Setup editor. 

Test the migrated application 
To test the migrated application, run the application on Workstation #1. 

1. On Workstation #1, start a FactoryTalk View SE Client configuration. 
2. Ensure that data communications are functioning as expected. 

Step 7: Upgrade selected runtime clients 
To upgrade the software components, install FactoryTalk View SE Client and any necessary products updates on the 
selected runtime clients. Perform these tasks on each client computer. For details, see the procedures that follow. 

• Install FactoryTalk View SE Client on page 55 
• Specify Server #2 as the Network Directory location on client computers on page 55 

Install FactoryTalk View SE Client 
If you already have the Client Install Portal feature installed on the HMI server, you can upgrade the clients through 
a web browser. For detailed instructions, see Install SE clients in a distributed system on page 30. Otherwise, you 
can use the installation package. Follow the instructions below. 

1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Site Edition Client and click Install now. 
4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 

25. 
5. After installation, install any necessary product updates. For more information, see Install product updates 

on page 65. 

Specify Server #2 as the Network Directory location on client computers 
After upgrading the software on the client computer, specify Server #2 as the Network Directory location. 

To specify Server #2 as the Network Directory: 
1. Select Start > Rockwell Software > Specify FactoryTalk Directory Location. 
2. Click the Browse button beside the field, Computer hosting directory server. 
3. In the FactoryTalk Directory Server Configuration dialog box, select Remote computer, type Server #2 and 

click OK. 

 
Tip: To change the Network Directory location, you have to log on as an administrator on 
the new Network Directory computer (local or remote). 

4. Click OK and then restart the client computer. 
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Step 8: Test the migrated application 
To test the migrated application before upgrading remaining application computers, perform these tasks: 

• Start Server #2 and wait for it to finish starting on page 56 
• Run the migrated application on upgraded clients on page 56 
• Verify that the system is functioning as expected on page 56 

Start Server #2 and wait for it to finish starting 
If Server #2 is not already started, start the server and wait for the server to finish starting. 

To confirm that Server #2 has finished starting: 
1. On Server #2, select Start > Rockwell Software > Diagnostics Viewer. 
2. In the FactoryTalk Diagnostics Viewer, check for the following Diagnostics message: 

The HMI Server <ApplicationName>//Server #2 is the active server. 

 
Tip: To find a message faster in the Diagnostics Viewer, on the View menu, click Options. 
Then, in the Filter tab, create a Message filter with one or more keywords from the 
message. 

 

Run the migrated application on upgraded clients 
On each of the upgraded runtime client computers, run the existing FactoryTalk View SE Client configuration file 
(.cli). 

Verify that the system is functioning as expected 
After the application starts running on the upgraded client computers, verify that display navigation, object 
animation, communications, alarming (if configured), and other applications features are functioning as expected. 

Part 3: Upgrade remaining clients and restore redundancy 
This part involves upgrading the remaining runtime clients and Server # 1, and restoring the redundancy. After 
upgrading, Server #2 becomes the primary server and Server #1 becomes secondary. 

 

Step 9: Upgrade remaining client computers 
After testing the partially upgraded system, on the remaining client computers, install FactoryTalk View SE Client 
and point at Server #2 as the Network Directory. Perform these tasks: 

• Install FactoryTalk View SE Client on page 55 
• Specify Server #2 as the Network Directory for remaining clients on page 55 
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Install FactoryTalk View SE Client 
If you already have the Client Install Portal feature installed on the HMI server, you can upgrade the clients through 
a web browser. For detailed instructions, see Install SE clients in a distributed system on page 30. Otherwise, you 
can use the installation package. Follow the instructions below. 

1. Close all open Windows programs. 
2. From the installation package, double-click Setup.exe. 
3. On the Setup page, select Site Edition Client and click Install now. 
4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 

25. 
5. After installation, install any necessary product updates. For more information, see Install product updates 

on page 65. 

Specify Server #2 as the Network Directory location on client computers 
After upgrading the software on the client computer, specify Server #2 as the Network Directory location. 

To specify Server #2 as the Network Directory: 
1. Select Start > Rockwell Software > Specify FactoryTalk Directory Location. 
2. Click the Browse button beside the field, Computer hosting directory server. 
3. In the FactoryTalk Directory Server Configuration dialog box, select Remote computer, type Server #2 and 

click OK. 

 
Tip: To change the Network Directory location, you have to log on as an administrator on 
the new Network Directory computer (local or remote). 

4. Click OK and then restart the client computer. 

Step 10: Upgrade Server #1 
To upgrade FactoryTalk View SE and supporting software on Server #1, install FactoryTalk View SE Server and set 
up Server #1 to point at Server #2. Perform these tasks: 

• Install FactoryTalk View SE Server on page 57 
• Specify Server #2 as the Network Directory for Server #1 on page 58 

Install FactoryTalk View SE Server on Server #1 
1. On Server #1, close all open Windows programs. 
2. Double-click Setup.exe within the installation package. 
3. On the Setup page, select Site Edition Server and click Install now. 
4. Follow the instructions to finish the installation. For more information, see Install FactoryTalk View on page 

25. 
5. After installation, install any necessary product updates. For more information, see Install product updates 

on page 65. 
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Specify Server #2 as the Network Directory for Server #1 
1. Select Start > Rockwell Software > Specify FactoryTalk Directory Location. 
2. Click the Browse button beside the field, Computer hosting directory server. 
3. In the FactoryTalk Directory Server Configuration dialog box, select Remote computer, type Server #2, and 

then click OK. 

 
Tip: To change the Network Directory location, you have to log on as an administrator on 
the new Network Directory computer (local or remote). In this case, the new location is 
remote. 

4. Click OK again, and then restart Server #1. 

Step 11: Restore redundancy and finish upgrading 
Before finishing the upgrade, you need to enable the redundancy and check the server status. If the status is not 
right, restart Server #1 and Server #2. Perform the following tasks: 

• Enable HMI and data server redundancy on page 58 
• Enable alarm and event history logging on page 58 
• Confirm the status of primary and secondary servers on page 59 
• Start all runtime clients on page 59 

Enable HMI and data server redundancy 
1. Select Start > FactoryTalk View Studio. 
2. In the Application Type Selection dialog box, select the application type and click Continue. 
3. On the Existing tab, select the application and click Open. 
4. In the Explorer window, right-click the HMI server and select Properties. 
5. (optional) On the General tab, make sure Load and run startup components when operating system 

initializes is selected. 
6. On the Redundancy tab, select the check box Provide redundancy using a secondary server. 
7. Under the Secondary Server area, type Server #1 and click OK. 
8. In the Explorer window, right-click the data server FactoryTalk Linx and select Properties. 
9. On the Redundancy tab, select the check box Provide redundancy using a secondary server. 
10. Under the Computer running secondary server field, type Server #1 and click OK. 
11. From the menu, select Tools > Options. On the Settings tab, make sure the Save edits to both active and 

standby HMI servers option is selected. 
12. To keep the HMI memory tag values the same on both active and standby servers, on the Settings tab, select 

the Auto synchronize HMI memory tag values to both active and standby HMI servers option. 

Enable alarm and event history logging 
If the alarm and event history logging is already disabled on Server #2, follow the steps below to enable the history 
logging. 

1. On Workstation #1, open the restored application in FactoryTalk View Studio. 
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2. In the Explorer window, right-click the Tag Alarm and Event server and select Properties. 
3. In the Priorities and History tab, select the Enable history check box, select the database and click OK. 

If your system has controller device-based alarms, follow the steps below to enable the history logging. 

1. In the Explorer window, right-click the FactoryTalk Linx Data server and select Properties. 
2. In the Alarms and Events tab, select the Enable history check box, select the database and click OK. 

Confirm the status of primary and secondary servers 
On Workstation #1, in FactoryTalk View Studio, right-click the HMI server and then select Server Status. 

In the Server Status dialog box: 

• Server #2 and Active status are displayed in the fields Primary server and Primary status respectively. 
• Server #1 and Standby status are displayed in the fields Secondary server and Secondary status respectively. 

 
Tip: To switch the Active server to Server #1, click Switchover. 

 

Start all runtime clients 
To ensure that the entire, upgraded application is functioning as expected, run the existing FactoryTalk View 
SE Client configuration file on each runtime client computer. 
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Appendix A 

FactoryTalk View tools and utilities 

FactoryTalk View provides tools to create powerful, dependable process monitoring and supervisory 
control applications. This section contains the tools for FactoryTalk View SE and FactoryTalk. 

To run the tools, select Start > Rockwell Software and then select the tool in the list of apps. The steps 
may vary depending on your operating system. 

FactoryTalk View tools 
Use the following tools for FactoryTalk View SE: 

• Application Documenter 

Used to view the contents of the application’s components and the tags used in these 
components. 

• DeskLock 

Used to prevent users of FactoryTalk View SE Client and FactoryTalk View ME from gaining 
access to the Windows desktop and system keys. 

• FactoryTalk View Alarm Migration Tool 

Used to migrates legacy HMI alarms to FactoryTalk Alarms and Events tag-based alarms. 

• FactoryTalk View File Viewer 

Used to view and save log files such as SE datalog files, ME datalog files, ME alarm log files and 
dBASE file. 

• FactoryTalk View SE Application Manager 

Formerly known as Distributed Application Manager, used to manage all types of SE applications 
(network distributed, network station, and local station). 

• FactoryTalk View SE Cache File Management Tool 

Used to manage the temporary files of HMI Server components. 

• FactoryTalk View SE Website Setup Tool 

Used to enable the HTTPS protocol over the default website and create a custom website on an 
HMI server computer. 

• HMI Server Backup and Restore 
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Used to back up FactoryTalk View SE HMI servers while they are running. Use this utility when 
backing up or restoring a stand-alone system, or when deploying a distributed system from one 
set of computers to another. 

• Legacy Tag Database Conversion Utility 

Used to convert legacy tag database (before View 6.0) to a new format to work with Microsoft SQL 
database. 

• SE Administration Console 

Used to administer FactoryTalk View SE applications after they are deployed. Use the sub-set of 
editors available in the Administration Console to make minor changes to an application without 
installing FactoryTalk View Studio. 

 
Tip: SE Administration Console will close automatically after being open for two hours. 

• SE Service Manager 

Used to stop or start the FactoryTalk View HMI Service manually on the computer. 

• Tag Import and Export Wizard 

Used to import or export the FactoryTalk View SE Server’s tag database. 

FactoryTalk tools 
Use the following tools for FactoryTalk or FactoryTalk Alarms and Events: 

• Diagnostics Viewer 

Used to view the contents of FactoryTalk Diagnostics logs, to help with troubleshooting the 
system. 

• FTAE Database Update Utility 

Used to merge the ConditionEvent and TrackingEvent tables into the AllEvent table in the same 
database. 

• FactoryTalk Diagnostics Counter Monitor 

Used to check the status of tags and to monitor the runtime values of counters and strings that 
are made available by network clients for diagnostic purposes. 

• FactoryTalk Directory Configuration Wizard 

Used to set up the FactoryTalk Network Directory or Local Directory on the computer. 

• FactoryTalk Live Data Test Client 

Used to test client and server data connections in an application. 

• Import RSSecurity Configuration 

Used to import RSSecurity setup information to FactoryTalk Security. 

• Log On to FactoryTalk 

Used to log users on and off the FactoryTalk Directory. 
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• RSSecurity Emulator Install 

Used to install the RSSecurity Emulator, which emulates an RSSecurity Server for legacy 
products. 

• Specify FactoryTalk Directory Location 

Used to specify which computer on the network contains the FactoryTalk Network Directory 
service. 

• Windows Firewall Configuration Utility 

Used to configure Windows firewall settings for FactoryTalk View. 

• FactoryTalk DB Connection Config Utility 

Used to simplify the configurations needed for using Windows authentication to access database. 
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Appendix B 

Common upgrade procedures 

This section contains notes, common procedures and information from the Rockwell Automation 
Knowledgebase that you may find helpful during installation of FactoryTalk View products. 

Install product updates 
After installing FactoryTalk View, we recommend installing the latest updates for your software. 

Rockwell Automation Knowledgebase provides the updates through the Patch Tables of Contents 
(TOCs). A Patch TOC describes updates released for a particular product and version, and provides 
instructions for downloading and installing the updates on computers where the software is installed. 

Use the FactoryTalk Updater tool to assist with the update. For instructions, see Update from the 
product on page 65. 

You can also manually search Rockwell Automation Knowledgebase and locate the latest updates. For 
instructions, see Update from Rockwell Automation Knowledgebase on page 66. 

Update from the product 
When you start the installation process for FactoryTalk View, FactoryTalk Updater Agent is installed by 
default. FactoryTalk Updater Agent is one of the components of FactoryTalk Updater. FactoryTalk 
Updater assists in management of installed Rockwell Automation software by announcing new versions 
and patch roll-ups for the software on your computer. Registering for updates is not required to receive 
announcements from the FactoryTalk Updater. 

FactoryTalk Updater includes: 

• FactoryTalk Updater Agent 

Collects information and activation license data from the Rockwell Automation software installed 
on the computer. 

• FactoryTalk Updater Client 

Displays information collected by the FactoryTalk Updater Server and enables you to review 
updates and patches. 

• FactoryTalk Updater Server 

Communicates with online FactoryTalk Updater Agents to receive collected data. 
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Connects to the Product Compatibility and Download Center to retrieve the latest software 
information. 
Responds to requests from the FactoryTalk Updater Client. 

 
Tip: To receive notifications of new versions and patch roll-ups, the tool requires access to 
the Download Center web service. Verify that the firewall does not block access to this URL: 
https://api.rockwellautomation.com/es-be-pcdc-vpcprod/ 

To update from the product: 
1. Download FactoryTalk Updater from the Product Compatibility and Download Center. 
2. Install the FactoryTalk Updater components. 
3. Open the FactoryTalk Updater. 

For more information about using FactoryTalk Updater, see the FactoryTalk Updater Help. 

Update from Rockwell Automation Knowledgebase 
You can also manually search and locate the latest updates in Rockwell Automation Knowledgebase. 

To update from Rockwell Automation Knowledgebase: 
1. From the web browser, open Rockwell Automation Knowledgebase at 

https://rockwellautomation.custhelp.com. 
2. In the search box, type Factorytalk View Patch TOC and select SEARCH. 
3. In the search results, look for Patch TOCs related to the products you installed. 
4. Follow the on-screen instructions to download and install the updates. 

 

https://compatibility.rockwellautomation.com/Pages/home.aspx
http://rockwellautomation.custhelp.com/
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Appendix C 

Install Microsoft IIS 

Microsoft Internet Information Services (IIS) is a critical service for a distributed FactoryTalk View SE 
System. The Setup wizard detects and installs IIS automatically if IIS is not available on the computer. 

This appendix servers as a reference to help you troubleshoot issues and verify IIS settings. 

The following table shows whether IIS is required on your computers: 

IIS required IIS not needed 

• FactoryTalk View SE Server 
• FactoryTalk View Studio that needs to remotely connect to a Network FactoryTalk 

View SE system. 

• FactoryTalk View SE Client 
• FactoryTalk View Studio 
• Stand Alone FactoryTalk Linx Server 
• Stand Alone FactoryTalk Directory Server 

 

Manually install IIS 
The steps may vary because of different versions and configurations. Follow the on-screen instructions 
that apply to the operating systems you are using. If necessary, install IIS from your Microsoft Windows 
operating system installation package. 

To install IIS on Windows10: 
1. Open Windows Control Panel, and click Programs. 
2. Under Programs and Features, click Turn Windows features on or off. The Windows Features 

dialog box will open. 
3. Click the checkbox to the left of Internet Information Services to enable settings. 
4. Expand the Web Management Tools folders, and then expand the IIS 6 Management 

Compatibility folder. 
5. Select the IIS Metabase and IIS 6 configuration compatibility check box. 
6. Expand the World Wide Web Services folder and then expand the Application Development 

Features folder. 
7. Select the ASP check box. The ISAPI Extensions check box should then be selected automatically. 
8. Under the World Wide Web Services folder, expand the Common HTTP Features folder. 
9. Under World Wide Web Services folder, expand the Security folder. 
10. Select the Windows Authentication and URL Authorization check boxes. 
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Tip: If IIS is installed correctly, you should be able to open the HMI server status page on 
localhost first, then from another computer. To test this, open Internet Explorer, in the 
address field, type http://localhost/rsviewse, or http://computername/rsviewse then 
press Enter. 

To install IIS on Windows Server 2019, 2016, or 2012: 
1. Select Start > Administrative Tools > Server Manager. 
2. In the Server Manager Dashboard window, click Add roles and features. 
3. Use the Add Roles and Features Wizard to add the Web Server (IIS) role. 
4. To install the Web Server, some additional Windows features might need to be installed. In each 

case, click Add Required Features. 
5. Click to expand Security, and then select the Windows Authentication and URL Authorization 

check boxes. 
6. Click to expand Application Development, and then select ASP. 
7. When prompted to install ISAPI Extensions, click Add Required Role Services. 

The following example shows the installation for Windows Server 2019. 

 
8. Click to expand Management Tools and then expand IIS 6 Management Compatibility. 
9. Under IIS 6 Management Compatibility, select IIS 6 Metabase Compatibility. 
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The following example shows the installation for Windows Server 2019. 

 
10. Click Next, and then accept the default selections at each remaining step of the wizard by clicking 

Next until all of the steps are complete. 
11. At the end of the wizard, click Install to install the Web Server role. 

About uninstalling IIS 
If for some reasons, you need to uninstall and then reinstall IIS, after reinstalling, you need to recreate 
the virtual directories in IIS. 

Use RSViewWebManager to recreate the virtual directories. The default location is: 

• C:\Program Files (x86)\Rockwell Software\RSView Enterprise\RSViewWebManager.exe for 64-bit 
operating systems 

• C:\Program Files\Rockwell Software\RSView Enterprise\RSViewWebManager.exe for 32-bit 
operating systems 
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Appendix D 

Use command-line installation 

You can typically use this installation method for unattended installation. 

The unattended installation is an automated installation method that reduces user interaction. It is 
typically used for large-scale rollouts when it might be too slow and costly to have administrators or 
technicians interactively install FactoryTalk View on individual computers. 

Perform command-line installation 
The command-line installation requires the administrator permission. The steps may vary slightly 
depending on your operating system. 

To perform command-line installation: 
1. Close all open Windows programs. 
2. Open the Command Prompt window. 
3. In the Command Prompt window, navigate to C:\Users\Public\Documents\FTView, where 

C:\Users\Public\Documents\FTView is the folder containing the FactoryTalk View installation 
package, and press Enter. 

4. If the User Account Control dialog box shows, click Yes. 
5. In the Command Prompt window, type a command line with the following syntax and press 

Enter. 
Setup.exe [/parameter=value] [...] 

For more information about parameters, type Setup.exe /? or see Command-line parameters on page 71. 

Command-line parameters 
Use command-line parameters to perform an unattended or silent installation of the software. 

Command-line parameters 

The following table identifies the installation command-line parameters. Command-line parameters are 
case-insensitive. However, if a specified value includes a space, be sure to enclose the value in quotation 
marks (for example, "value with spaces"). 

Parameter Description 

/? Displays the usage options for installation parameters. 
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Parameter Description 

/Q Silent Install, install runs in a quiet mode without any user interface. 
This parameter is recommended when deploying the software installation using an IT tool or script, 
and don’t expect any error or restart messages. When using this parameter, check the error codes, 
and respond as needed. For example, if the installation returns error code 1641, then the IT tool or 
script should restart the computer and relaunch the installation after restart. 
This parameter is required if /QS is not specified. 

/QS Unattended Install, install runs in a quiet simple mode and shows progress through the UI, it does not 
accept any input but still shows error or restart messages. 
When using this parameter, the installation will stop and display a prompt if there are error or restart 
messages. For example, if an immediate restart is required to complete the install, a restart message 
will be displayed to confirm the restart. Installation resumes automatically from the point of 
interruption after restart. 
This parameter is required if /Q is not specified. 

/IAcceptAllLicenseTerms Acknowledges acceptance of the license terms. 
This parameter is required for /Q or /QS parameters. 

/AutoRestart Automatically restarts the computer after the installation is complete. Used when a restart is 
required to complete the installation. 
This parameter is optional. If this parameter is not used, silent install (/Q) will return either error code 
1641 or 3010 if a restart is required, and unattended install (/QS) will result in a confirmation prompt 
that must be agreed to before the installation is completed. 

/Record Records the installation options chosen to a recording file. 
This parameter is optional. 

/Playback Plays back a recording file to specify the installation options. 
This parameter is optional. 

/Repair Runs a repair operation on the installed products. 
This parameter is optional. 

/Uninstall Uninstalls the product. 
/SetupLanguage="value" Specifies which language will be displayed during install process. 

The value must be the one of the following: 
• ENU 
• CHS 
• DEU 
• ESP 
• FRA 
• ITA 
• JPN 
• KOR 
• PTB 
This parameter is optional. If this parameter is not used, the default language is the current user or 
operating system user interface language. 
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Parameter Description 

/Product="value" Specifies which sub-products will be installed. 
This parameter is required. 
For FactoryTalk View ME, the value must be one of the following: 
• Studio for Machine Edition 
• Machine Edition Station for Windows 
• Stand-alone ME Transfer Utility 
For FactoryTalk View SE, the value must be one of the following: 
• Studio Enterprise 
• Site Edition Server 
• Site Edition Client 
• Site Edition Station 
• FactoryTalk ViewPoint SE 
• Stand-alone FactoryTalk Linx Server 
• Stand-alone FactoryTalk Directory Server 

/ProductLanguage="value" Specifies the language version of the software being installed. 
The value must be one of the following: 
• ENU 
• CHS 
• DEU 
• FRA 
• JPN 
This parameter is optional. If this parameter is not used, the default language is the same as the 
setup language. 
If the software does not support multiple languages, this parameter is not available. 

/InstallDrive="value" Specifies the installation drive. 
This parameter is optional. If this parameter is not used, the default install drive is C:. 

/IgnoreWarning Specifies that the setup ignores warnings and continues. 
This parameter is optional. If it is not specified, the setup exits when a warning occurs. 

/SerialNumber="value" Specifies the serial number of the software being installed. This is used to activate the software 
during installation. 
This parameter is optional. If it is not specified, the software must be activated manually after 
installation if activation is required. 
Some software does not require activation. If activation is not required, this parameter is not 
available. 

/ProductKey="value" Specifies the product key used to get activation keys during installation. 
This parameter is optional. If it is not specified, the software must be activated manually after 
installation if activation is required.  
Some software does not require activation. If activation is not required, this parameter is not 
available. 
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Parameter Description 

/Version="value" Specifies the version of the software to activate, which corresponds to the product version 
associated with the SerialNumber and ProductKey. 
This parameter is optional. If it is not specified, the installer will use the most recent product version 
available. 
Some software does not require activation. If activation is not required, this parameter is not 
available. 

/DirectoryServer="value" Specifies the FactoryTalk network directory if you are using a distributed system. 
This parameter is optional. If it is not specified, the software will use its current computer as the 
FactoryTalk Directory server. 
The value must be the host name of the FactoryTalk Directory server. 

/NoHTTPS Specifies that the setup turns off HTTPS. 
This parameter is optional. If it is not specified, the setup turns on HTTPS for communication, and a 
TLS certificate must be configured after installation. 

For FactoryTalk Services Platform commands to back up and restore directory, system, and applications, 
see FactoryTalk Security System Configuration Guide. 

Error codes 

The following table identifies the error codes that can be returned by an installation. 

Error Code Value Description 

ERROR_SUCCESS 0 The installation completed successfully. 
ERROR_INVALID_PARAMETER 87 One of the parameters was invalid. 
ERROR_INSTALL_USEREXIT 1602 The installation was canceled by the user. 
ERROR_INSTALL_FAILURE 1603 A fatal error occurred during installation. 

ERROR_BAD_CONFIGURATION 1610 The configuration data for this product is corrupt. Contact your support personnel. 
ERROR_SUCCESS_REBOOT_INITIATED 1641 The installer has initiated a restart. After restart, the installation will continue. 
ERROR_SUCCESS_REBOOT_REQUIRED 3010 A restart is required to complete the installation. After restart, the product is 

successfully installed. 
ERROR_REBOOT_PENDING 3012 Restart pending. Restart the computer for the installation to continue. 
ERROR_SUCCESS_NOT_APPLICABLE 3013 The installation cannot proceed because the products are already installed. 

ERROR_SUCCESS_WARNING_REBOOT 3014 The installation succeeded with warnings. Check the installation log file for details. 
To complete the installation, restart the computer. 

 

Examples 
The following examples show how to use the commands for the installation. 

Example 1: Install with default settings 
Setup.exe /Q /IAcceptAllLicenseTerms /Product="Studio Enterprise" 

means: 

• FactoryTalk View Studio Enterprise will be installed with default settings. 
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Example 2: Install with customized settings 
Setup.exe /QS /IAcceptAllLicenseTerms /AutoRestart /SetupLanguage=CHS 
/Product="Site Edition Client" /SerialNumber=0123456789 /ProductKey=ABCDE-FGHIJ 
/Version=10.00.00 

means: 

• FactoryTalk View Site Edition Client version 10.00.00 will be installed. 
• The displayed language is Chinese during the installation. 
• The setup will get activation keys during installation if the serial number 0123456789 and product 

key ABCDE-FGHIJ are valid. 
• After the installation, if a restart is required, the computer will be restarted automatically. 

Example 3: Install with customized FactoryTalk Directory server 
Setup.exe /Q /IAcceptAllLicenseTerms /Product="Studio Enterprise" 
/DirectoryServer=ServerName 

means: 

• FactoryTalk View Studio Enterprise will be installed with customized FactoryTalk Directory 
server. ServerName is host name of the customized FactoryTalk Directory server. 

Example 4: Install and record selections 
Setup.exe /Record 

means: 

• FactoryTalk View will open the Setup wizard and record your selections during the installation. 
• When complete, FactoryTalk View will save the recording file to your desktop. 

Example 5: Install with a recording file 
Setup.exe /Q /IAcceptAllLicenseTerms /Playback="C:\Users\Public\FactoryTalk View 
Studio Enterprise.rec" 

means: 

• FactoryTalk View will use the recording file FactoryTalk View Studio Enterprise.rec to complete the 
installation. 

Example 6: Uninstall 
Setup.exe /Q /Uninstall /Product="Studio Enterprise" 

means: 

• FactoryTalk View Studio Enterprise and the components that are installed with FactoryTalk View 
Studio Enterprise will be uninstalled. 
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• Components, such as FactoryTalk Activation Manager, that are shared with other products will 
not be uninstalled. 
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Legal Notices 

Legal Notices 
Rockwell Automation publishes legal notices, such as privacy policies, license agreements, trademark disclosures, 
and other terms and conditions on the Legal Notices page of the Rockwell Automation website. 

End User License Agreement (EULA) 

You can view the Rockwell Automation End User License Agreement (EULA) by opening the license.rtf file located in 
your product's install folder on your hard drive. 

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf. 

Open Source Software Licenses 

The software included in this product contains copyrighted software that is licensed under one or more open source 
licenses. 

You can view a full list of all open source software used in this product and their corresponding licenses by opening 
the oss_license.txt file located in your product's OPENSOURCE folder on your hard drive. This file is divided into 
these sections: 

• Components 

Includes the name of the open source component, its version number, and the type of license. 

• Copyright Text 

Includes the name of the open source component, its version number, and the copyright declaration. 

• Licenses 

Includes the name of the license, the list of open source components citing the license, and the terms of the 
license. 

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\<product name>\Release 
Notes\OPENSOURCE\oss_licenses.txt. 

You may obtain Corresponding Source code for open source packages included in this product from their respective 
project web site(s). Alternatively, you may obtain complete Corresponding Source code by contacting Rockwell 
Automation via the Contact form on the Rockwell Automation website: 
http://www.rockwellautomation.com/global/about-us/contact/contact.page. Please include "Open Source" as part of 
the request text. 

Commercial Software Licenses 

This software also includes these commercially licensed software components: 

https://www.rockwellautomation.com/global/legal-notices/overview.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page


 

78 Rockwell Automation Publication VIEWSE-IN003S-EN-E - March 2022  
 

Component Copyright 

PDFControls.NET 2.0.113 Copyright 2002-2021 TallComponents BV. 

Symbol Factory 3.0 Copyright 1996-2020 Software Toolbox, Inc. 
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controller requirements  17 
design considerations  17 
setting up  17 

E 

engineering workstations 
upgrading  49 

F 

FactoryTalk Alarms and Events 
hardware requirements  15 

FactoryTalk Diagnostics Viewer  51 
FactoryTalk Directory  10 
FactoryTalk Directory Configuration Wizard  56 
FactoryTalk Services Platform  12 
FactoryTalk tools and utilities  56 
FactoryTalk View SE Cache Management Tool  55 
FactoryTalk View SE Client  10 

copying client files  37 
creating new client files  36 
file locations  37 
setting up security  36 

FactoryTalk View SE Server  10 
FactoryTalk View Site Edition  9 

installing  23 
upgrading  39 

FactoryTalk View Studio  9 
file locations 

SE Client files  37 
finding information 

on the Internet  7 

technical support  7 
firewalls 

third-party incompatible  20 
folders 

SE Client files  37 

G 

grace period 
activating FactoryTalk View SE  29 

H 

hardware requirements  15 
FactoryTalk Alarms and Events  15 

HMI Server Backup and Restore utility  55 
HMI servers  10, 35 

starting or stopping  35 
synchronizing with projects  35 

HTTPS  26 

I 
Import RSSecurity Configuration  56 
incompatible firewalls  20 
installing 

FactoryTalk View SE  23 
product updates  59 
troubleshooting  39 
upgrading  39 

Internet Explorer 
removing enhanced security configuration  20 

Internet Information Services (IIS) 
configuring  61 
uninstalling  63 

Internet technical support  7 
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keys 
FactoryTalk Activation  29 
sharing for FactoryTalk Activation  30 

knowledgebase  17, 59 
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local applications 
administering at runtime  37 
security  36 
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moving files 
data servers  34 

N 

naming 
computers  18 
troubleshooting computer names  18 

network applications 
security  36 

Network Directory 
specifying location  26, 48 

network interface cards (NIC) 
troubleshooting  19 

network switches 
troubleshooting  19 

networks 
removing unnecessary DCOM protocols  21 
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OLE for Process Control (OPC) 
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operating systems 
requirements  16 

operator workstations 
upgrading  50 

overview 
upgrading redundant applications  44 
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ports 
troubleshooting on network switches  19 

product updates 
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redundancy 
disabling for upgrade  48 
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replicating changes  35 
servers  49 
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troubleshooting  35 
replication 

of redundant servers  35 
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runtime 
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SE Service Manager  55 
security 
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backing up and restoring  49 
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Uninstall FactoryTalk View  55 
unmanaged switches 
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Rockwell Automation support 
Use these resources to access support information. 

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 
updates. 

rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and 
find associated firmware. 

rok.auto/pcdc 

 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

 
At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 

 

http://rok.auto/support
http://rok.auto/knowledgebase
http://rok.auto/phonesupport
http://rok.auto/literature
http://rok.auto/pcdc
http://rok.auto/docfeedback
http://rok.auto/pec
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